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Introduction

File preparation for press is often not thought about in great depth by those not used to the trade, until the last
moment when the project finally comes to printed. All of a sudden a whole host of technical jargon and requirements
are thrust upon you, when you have the least amount of time to spare before that inevitable book-launch.

Hence the aim of this guide - to teach you a few technical requirements and aid you in preparing print-ready PDF files
that CMP can use first time.

Service Expectations

Files supplied to CMP are checked (“preflighted”) when they arrive at our prepress department for the technical
requirements of commercial printing, and “Fit For Purpose” checked against the job brief -i.e. does the artwork match
the order’s size, and are the cover dimensions correct for the expected size of book? etc. It should be noted that files
supplied to us are expected to have already been proof-read — CMP do not check for spelling and grammar. It is
more cost-effective for any typographical amendments to have been affected before hand.

What is a PDF and Why use it?

The most reliable and accurate method to transfer files between your system, through prepress and imposition schemes
(where several pages are printed on one larger sheet of paper), and thence on to the press is to use a portable file
format -the industry standard PDF.

PDF (portable Document Format) “locks” the words and images in place on the page

and when set up correctly ensures that everything needed for printing is contained (or embedded) within the one file,
so regardless of computer platform or printing press, the end printed result is the same.

Unlike supplying a Word file, for example - Word files do not transfer well between systems, as they rely on the
individual computer’s fonts and printer settings, which vary from computer to computer.

PDF’s can be made from any program, because it is based on printer code - imagine sending a document to your



desktop printer - the data that goes down the cable to the printer gets captured to a file that can then be released to
another printer miles away - that’s the essence of PDF.

In fact one method of creating a PDF is to print a document to a “PDF printer”, which actually saves a file to disk instead
of sending the data to a printer. Nowadays programs can simply “save as” PDF, but the internal process is the same.

Choosing a program to use to create your PDF

There are many page layout and desktop publishing programs that are capable of creating a PDF, and different programs
are good at doing different things.

QuarkXpress and InDesign are the de-facto industry standard page layout programs, if you are serious about designing
lots of titles, one of these would be well worth the investment in money and the time to learn the complexities of
them. With these programs you can get very professional effects and results that mainstream publishers output. Other
programs are also available, that may produce results suitable for your project with less of a price tag.

Any program that can print to printer can be used to create a PDF -
If you can’t save-as or export to PDF, you can always print to PDF by using a PDF printer - remember that’s a virtual
printer that saves the file to PDF. Free ones like Nitro and CutePDF are available on-line, while Acrobat Professional is

the industry-standard PDF creating and reading program.

As long as the resulting PDF meets the specifications outlined in this booklet, the creating program is less important.
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Components of a Book

There are a variety of different book styles that can be produced, each having different components that each require
a separate PDF with which to print from.

Saddle-stitched Booklets

have a set of inner pages and often an outer (thicker) cover, folded
in half with two staples in the spine to keep it all together. The
folded booklet is then trimmed flush to the specified size.

Components: Cover, Text

Paperback (Limp) Books

have a “book block” (set of pages often printed on a white light
weight paper) and a card cover (usually printed in colour) glued
to the spine (“bound”), and trimmed flush to the specified size.

Components: Cover, Text.

Hardback (Cased) Books

have the book block bound on the spine with front and back
endpapers (which can be plain heavyweight paper, coloured or
printed), and trimmed to the specified size. This trimmed book-
block is then “cased-in” — the hard cover (or “case”) is glued to
the front and back endpapers (not the spine) and overhangs
the bookblock by about 3mm. The case can be either finished in
cloth or a printed papercase (“PPC”). A cloth cover can have a
“blocking” applied (lettering or simple graphics stamp embossed
usually in gold or silver). A dust-jacket can also be wrapped around
the finished book.

Components: Text, Printed Endpapers, PPC, Jacket, Brass
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Bleed

Bleed is a fundamental requirement of printing, yet is often overlooked as it is not obvious to the end reader that it is
required.

Bleed is extra print that goes beyond the finished page size, and is only required when the print is to fall-off the finished
page. Book pages are printed on larger sheets of paper, then trimmed to exact size. Bleed is necessary due to the
variation of the relative position of the print on the sheet, which can occur at various stages in the production - such
as printing, folding and trimming. Therefore, given a little extra image (typically 3mm), the final trimmed product will
always appear printed to the very edge.

13 -5

The image on the above artwork is set 3mm beyond the finished page size (i.e. it bleeds correctly). Therefore
the image, once printed and trimmed to final size always goes to the edge of the page, even when variation
occurs in position through production processes.

The image on the above artwork is set to stop at the edge of the finished page size. (i.e. it doesn’t bleed correctly).

When production variations effect the print position, white may show at some of the edges once trimmed to final
size.
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Image Resolution

Here’s a collection of images at different resolutions for you to evaluate their quality. An image’s resolution can be
found using Photoshop: Image Menu -> Image Size. For colour/monochrome photographs, 300dpi is the optimum
resolution to use. For 1-bit images (e.g. scanned text / logos) 600-1200dpi is best.

Remember that by enlarging or reducing the
image, it’s resolution is also affected. For example,
a fair 200dpi image doubled in size will reduce it’s
resolution to a poor 100dpi.
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Colour

Computer monitors emit colour as RGB (red, green, blue) light. Although all colours of the visible spectrum can be
produced by merging red, green and blue light, monitors are capable of displaying only a limited gamut (i.e., range) of
the visible spectrum.

Whereas monitors emit light, inked paper absorbs or reflects specific wavelengths. Cyan, magenta and yellow pigments
serve as filters, subtracting varying degrees of red, green and blue from white light to produce a selective gamut of
colours. Like monitors, printing inks also produce a colour gamut that is only a subset of the visible spectrum, and the
colour range is not the same for both, and is wider on RGB than CMYK. To add to this the CMYK model is also subject to
the ambient lighting conditions - e.g. a printed page viewed in sunlight will appear differently to that in incandescent
light. Consequently, the same art displayed on a computer monitor may not match to that printed in a publication.

Because printing processes use CMYK (cyan, magenta, yellow, black) inks, digital art must be converted from the RGB
(Red Green Blue) colour for displaying on a monitor to CMYK colour for print, at some point in the design/print process.

RGB CMYK

If your page layout software is capable of CMYK workflow, use CMYK based colours, and convert source images to
CMVYK (e.g. using Photoshop) before placing into your page layout program. For best colour conversion use a FOGRA
colour profile if available.

Where this is not possible, we can accept RGB images, but please note that RGB will be converted to CMYK on the
press, and the colour conversion may not be as good as the method described above. Most digital devices (such as
digital cameras) tag the RGB image with a source colour profile, which makes the RGB conversion more accurate.

Spot Colours

If printing Offset Litho method, you can increase the range of colours by adding one or more spot colours from a
Pantone colour swatchbook.

Digital printing only uses the CMYK primaries, so ' .
any spot colours used are converted on the press &
to CMYK. However using spot colours on a digital
product can be a more accurate way of colour |
matching - Pantone to CMYK conversion will be a
closer match than trying to matching a colour on a 5

RGB monitor screen.
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Outputting PDF

Before generating a PDF file for the text element of your book, here’s a number of tips to make the book look more
professional and process with less likelihood of problems:

* Ensure the document page size matches the size of the book. The only exception to this is if your document
requires bleed and the program you are using doesn’t support it (e.g.) MS Word - in this instance the document
page size should be set to 6mm bigger than required (remembering that 3mm will be trimmed off each edge);

* Make use of the text justification settings - e.g. centre headings (don’t keep pressing space until it looks centred!),
while fully justified aligns the text to both left and right margins;

e Use tabulation (or the Tab key) on contents, indexes and tables to keep lists in line;

e Use page numbering. It’s conventional not to have a page number on the title pages, and use roman numerals for
the preliminary pages, starting the first chapter as page one on a right-hand (facing) page.

e Usegood quality images (300dpiis optimum, anything below 150dpi will start to look pixellated in print) - remember
that an image scaled up to twice the size will half it’s resolution.

e Ensure that all fonts used in the document are available to your computer (otherwise the font will not embed into
the PDF)

Most modern programs can save or export to PDF. Below are the generic settings to employ on professional-grade
software:

* Composite Output (e.g. all colours on one page, not separated)

*  Fonts: All embedded or subset

* Bleed 3mm

¢  Trim marks: on, offset: 5mm

* Include Blank pages

* Do Not enable reader’s spreads

* Image compression: Colour & Greyscale: 300dpi, mono/bitmap: 1200dpi.

If available, using “PDF/a” standard will ensure fonts are embedded.
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Creating PDF from Microsoft Word 2007:

To be able to create a print ready PDF in Word 2007 you will need to check whether you have the
add on to do this already installed on your PC.

To check go to the Office @button in Word 2007 (top left hand corner) and click on it so that it
drops down. Hover your mouse over the Save As options.
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Before you press the Publish button check that Standard is selected

on the Options button.
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Creating PDF from Microsoft Word 2008 for Mac:
It is very easy to create print ready PDFs for text only books using Mac Word 2008.

When you are ready to create your PDF then simply go to File / Save As... and
choose PDF from the drop down list to the right of the Format box.

Save As: Creating print ready PDFs from Mac Wc¢ ':‘

(<« |» ] [z2|=hm) ‘. (4] Applications s \ Q search
@ All... | Address Boo 8
] Adobe
PLACES 1 Adobe Acrobat 9 Pro
E Desktop @ Adobe Bridge C54
_('D nickypre... {8 Adobe De...entral C54
ﬁ"'-;-;--——--.- a Adobe Drive CS54

7 Documents @7 Adnhe Fy  naner (S4 I
£ AliclosDe

Format: ' PDF

document to a PDF file, which looks the same on Macintosh and

" Append file extension

Options. Compatibility Report.

 New Folder (Cancel'\ [ Save \

And that is all there is to it!

Once you have created the PDF then do a quick check just to make sure that fonts
are all embedded. Open the PDF file and go to File / Properties and then the Fonts
tab and make sure the words (Embedded Subset) are to the right of the font names.

Document Properties

{ Description Security Fonts Initial View Custom Advanced

Fonts Used in this Document

v 77| Arial-BoldMT (Embedded Subset)
Type: TrueType
Encoding: Roman

v [ 7] ArialMT (Embedded Subset)
Type: TrueType
Encoding: Roman

v ﬁ-]Cambria (Embedded Subset)
Type: TrueType
Encoding: Built-in

_ Help _Cancel _ oK
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Creating PDF from Microsoft Word 2010:
Creating print ready PDF files in Word 2010 is very straightforward.

When you are ready to make your Word document into a print ready PDF then go to File then Save
As and let Save as type drop down and then choose PDF.

(W] Save As @
@ o 5 » Libraries » Documents » v |+ Search Documents o]
S, [4]| - A E 4
Organize ¥ New folder =~ @ J j ; g 4| =
I rence Header Footer Page Text Quick WordArt
Templates e : - v Number~ | Box~ Parts~
Doguments library Arrange by: Folder ¥ Header & Footer Text
Inclufles: 2 locations )
7 Favorites =
B Desktop Nam Date modified Type  *
& Downloads i & Ny Music File folde| _
| Recent Places =| Ny Pictures File folde
& Ny Videos File folde
4 Libraries Qutlook Files File folde . .
N = Areos e items that are designed to
) Music = s - jrdocument. You can use these

= Pictures il J

Filename: On theInsel

ters, lists, coverpages, and other
~ |create pictures, charts, or

Save as type: |PDF

~| |ourcurrentdocumentlook.

Authors: Nicky Prentis

Optimize for: @ Standard (publishing
online and printing)

Minimum size
(publishing online)

# Hide Folders

Tags: Addatag of selected textin the document

bd textfrom the Quick Styles gallery
ttext directly by using the other

ols offera choice of using the look
matthat you specify directly.

cument, choose new Theme

Page:1of1 | Words: 238 | <8 |

Before you click Save click on the button that says Options an

elements onthe Pag®layouttab. To change the looks available in the
Quick Style gallery, usethe Change Current Quick Style Set command.
Both the Themes gallery aid the Quick Styles gallery provide reset
commands sothat you can allays restore the look of your documentto
the original contained in your curignttemplate.

On the Inserttab, the galleries includ&jtems that are designed to
coordinate with the overalllook of your dacument. You can use these

=l Pictures 2l

File name: Onthe

Save as type: [PDF

Authors: Nicky Pr| PPF options

Optimize for: @ §

crypt the document w

/ : er publishing
,

(W] Save As = |
W [E » Libraries » Documents » - “y | [ search Documents 2| - =
Organize v New folder | OPtiONS [-2-](mza] B v j Q g J A < Q
rence Header Footer Page Text Quick WordArt
Templates + | Pagerange - *  Number~ Boxv Partsv  ~
@ Al Arrange by:  Folder, Header & Footer Text
§ . Current page
¢ Favorites -
EEecn e modified -
B Desktop | Page(s) From To: [1
8 Downloads File folde|_
= Recent Places Publchiwhiat File folde i
© Document .
D File folde
o Document showing markup
4 Libraries File folde . .
2o Include non-printing information e items that are designed to
<| Documents
& Music urdocument. You can use these

ters, lists, coverpages, and other
create pictures, charts, or
ourcurrentdocumentlook.

of selected textin the document
ed textfrom the Quick Styles gallery
ttext directly by using the other

ols offera choice of using the look

4 Hide Folders

matthat you specify directly.

cument, choose new Theme

Page:10f1 | Words:238 | <& |

elements onthe Page Layouttab. To change the looks available in the
Quick Style gallery, use the Change Current Quick Style Set command.
Both the Themes gallery and the Quick Styles gallery provide reset
commands sothat you can always restore the look of your documentto
the original contained in your currenttemplate.

On the Insert tab, the galleries include items that are designed to
coordinate with the overalllook of your document. You can use these
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Output Styles

All Output Styles

Show

Default PDF Qutput Style
Default Print Output Style

PDF/X-1a:2001 |
PDF/X-3:2002 |

| _Press - High Quality/High Resolution [
Print - Medium Quality/Medium Resalution
Screen - Low Quality/Low Resclution =
Screen - Medium Quality/Low Resolution b4

Style Mame: Prass
Output Media: PDF

- High Quality/High Resolution

Edit PDF Style

Creating PDF from QuarkXpress:

From Edit menu, output styles,
duplicate [Press Quality] as a
basis and check the following
settings...

PDF Style: [Press - High Quality/High Resolution copy

Verification: | None

ar

"include blank

Pages Page Options

Meta Data "] Spreads

g;?:pr?::(:l-m "] Export pages as separate PDFs

Calor ™ Include Blank Pages

Fonts

Marks [] Embed Thumbnail | Colar Thumbnail
Bleed

Transparency

OPI

|DF

Summary Edit PDF Style

PDF Style:

Press - High Quality/High Resolution copy

Verification: | None

a
)

Pages

Meta Data
Hyperlinks
Compression
Calor

Maode

Setup

Fonts

Marks

Bleed
Transparency
orl

IDF

Summary

Color Dptions

: | Composite t]

2| Asis :l

Edit PDF Style

Ensure "Spreads" is OFF

pages" option ON

Set colour
conversion to none

PDF Style: |Press - High Quality/High Resolution copy

Verification: | None

Registration marks,
3mm offset,

Save PDF Style as "CMP" to
use later without having to change
the settings again!

Pages Registration Marks Options
Meta Data Mode: | Centered B3]
Hyperlinks )
Compression Width: 0.088 mm

Color —
Fonts Length: |4.933 mm

Marks

Bleed Offset: |3.175 mm
Transparency

Pl

IDF [] Include Bleed Marks
Summary

Edit PDF Style

PDF Style:

Press - High Quality/High Resolution copy

Verification: | None

Pages

Meta Data
Hyperlinks
Compression

Calar

Fonts

Marks

Bleed
Transparency
OPl

IDF

Summary

3mm Symetric
Bleed

Bleed Options

Bleed Type: ': Symmetric F ':';

Amount:  3.175 mm Left

3.175 mm

Bottom: 3.175 mm Right: 3.175 mm

E Clip at Bleed Edge

Cancel f 0K a

Now to save your document as a PDF, File menu - Export - Layout as PDF, and choose

your "CMP" PDF style in the PDF s

16
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Export Adobe PDF

" Creating PDF from InDesign:

Adobe PDF Preset: '_ [Press Quality]
Standard: | None |~€“I Compatibility: | Acrobat 5 (PDF 1.4) .
From File menu - Adobe PDF
General .
e presets - use [Press Quality] as a
‘ompression . a
Matks:and Rlaeds Description: |Use these settings to create Adobe PDF documents best baSIS, and CheCk the fO"OWIng
ONTBIR suited for high-quality prepress printing. Created PDF tt
e documents can be opened with Acrobat and Adobe Reader se |ngS--
: 5.0 and later.
Sacurity
Surmmary
— Pages
@ all
() Range: |1
"] Spreads
n "
Ensure "Spreads" is OFF
— Options
"1 Embed Page Thumbnails E‘ View PDF after Exporting
E Optimise for Fast Web View Create Acrobat Layers
"1 Create Tagged PDF
Export Layers: | Visible & Printable Layers l—%—l
— Include
[ Bookmarks "1 Non-Printing Objects
"1 Hyperlinks interactive Elements
il . .
! Visible Guides and Grids Multimedia: | Use Object Settings
Export Adobe PDF
( Save Preset... | - -
 — Adobe PDF Preset: | [Press Quality] (modified) |"€"!
Standard: | None F-H Compatibility: | Acrobat 5 (PDF 1.4) |'¢”l
Coral Marks and Bleeds
Compression _ Marks
Marks and Blaads
Output [=] All Printer's Marks Type: | Default 4 Crop Marks ON
Advanced E CFOD Marks Waight: |m ’
Security [ Bleed Marks A : x 5mm Offset,
Summary "1 Registration Marks Offset: <+ 5 mm
[ Colour Bars
"1 Page Information
— Bleed and Slug
"1 Use Document Bleed Settings
Bleed: S .
Top: =+ 3 mm Inside: 53 mm 3mm ymetrlc
Bottom: <+ 3 mm Outside: <3 mm Bleed
linclude Slug Area
Export Adobe PDF
Adobe PDF Preset: | [Press Quality] (modified) I-:l
Standard: | None lfé-{ Compatibility: | Acrobat 5 (PDF 1.4) I-i"l
( Save Preset... ) el Output
Compression = ehlalir
Marks and Bleads -
Output Colour Conversion: | No Colour Conversion F"ﬂ
Adianced Destination: | NJA =
Sacurity
o Profile Inclusion Policy: | Don't Include Profiles |‘$"!
Set colour "
conversion to none | Simulate Overprint [ Ink Manager... |
— PDF/X
QOutput Intent Profile Name: ' N/A =
n "
Sav_e Preset _as CMP .to use Output Condition Name: N/A
again later without having to L _
. Output Condition Identifier: N/A
change the settings.
Registry Name: N/A
— Description
CIiCk " EXpOI’t" to Pasition the pointer over a heading to view a description.
save your PDF
Save Preset... ( cancel ) ( Export )
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Checking the created PDF...

After outputting to PDF, open the PDF in Acrobat Reader and perform the following checks:

¢ All pages have output.

e Text and images generally appear as they should print.

* Pages appear in the order they should print: to help you visualise as a book, use facing pages (with cover page) in
the View/Page Layout menu.

* Fonts are embedded:

To check that the fonts are embedded then open your PDF in Acrobat Reader and choose File
and Properties

W90 Documentl. - Microsoft Word o @ =
- H @ 0
2 On the Insert tab.pcf - Adobe Reader o[- E @ —
| |G ot View Whdow Help x feete 0

& Time

c Open... Ctrl+0 = — ] lgeeci! Equation Symbol
o B0 | =) (o) | 103% . | & l B2 | | Tools . Sign | Comment ||, . quation Symbo
T2 CreatePDF Online. Symbols

i R nd has been opened read-only to prevent modification.
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on the Home tab. You can also format text directly by using the other
controls on the Home tab. Most controls offer a choice of using the look
from the current theme or using a format that you specify directly.

To change the overall look of your document, choose new Theme
elements on the Page Layout tab. To change the looks available in the
Quick Style gallery, use the Change Current Quick Style Set command.
Both the Themes gallery and the Quick Styles gallery provide reset
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Creating Cover
Layouts

“Don’t judge a book by it’s cover” - yet a well designed cover of a book can be crucial to it’s success. Therefore it may
be well worth considering getting a professional designer to do the work for you. If you do decide to prepare the
artwork yourself, read on.

The outer cover, be it a paperback, hardback jacket, or printed paper case, is printed separately from the text block,
and is joined to it at binding stage. It is also quite likely to be printed on a different press, therefore needs to be
supplied as a separate single PDF file. Imagine opening the book and turn it cover face up so you see the back cover,
spine and front cover from left to right facing you. That’s roughly how the PDF should look that is supplied for printing.
Your customer service representative will provide you with a tailored flat plan, with all the measurements required to
produce cover artwork specific to your book — the specific paper used on your book and the number of pages in it will
be used to calculate the width of the spine. The following pages walk you though examples of each of the flat plans
and the design requirements for a professional looking finish.

If you're using a professional Desktop Publishing program to design your cover (such as Quark or InDesign), you should
set the document size to the size of the cover as indicated on the flat-plan excluding bleed - as the bleed will be
allowed for on output. Remember though to extend any bleeding objects beyond the pasteboard by at least 3mm. The
program can automatically add trim marks when output to PDF.

If you’re using a program that doesn’t allow for bleed on PDF output (such as Word or Photoshop), set the document
size to the overall size of the cover as indicated on the flat-plan including bleed. Remember that 3mm will be trimmed

off each edge, so keep any objects that shouldn’t bleed well away from the edges.

Set guides (if available) to key points of the artwork (such as the spine - as indicated on the flat-plans) to aid getting the
right dimensions while assembling the artwork.
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Paperback Cover Artwork:
| |

328.8

240 234 156

Back Front

334.8

In this example, the trim page size of the book is 1I56mm width by 234mm height. The spine width 16.8mm, therefore
the visible width (“excluding bleed”) = 156+156+16.8=328.8mm

With 3mm bleed either side, the overall width of the artwork (“including bleed”) is then = 334.8mm

The visible height (“excluding bleed”) = 234mm. With 3mm bleed top and bottom, the overall height of the artwork
(“including bleed”) is then = 240mm.

NOTE that because paper is a natural product, and is affected by atmospheric conditions, the actual spine bulk can vary
slightly. Therefore a good design will take this into consideration by, for example, not having a spine a different colour
to the front and back, but to take the design around at least one side of the spine. That way, any fluctuation in spine
width goes unnoticed on the final bound book. Such as the example below - the spine background extends to the back
and front of the cover.

Also notice the trim marks
identifying the final trim size,
and that the backgrounds and
images extend beyond for
the bleed. All the readable
text is a good distance from
the edge so that it’s not in
danger of being trimmed off
in production. Marks have
also been added showing

Exploring the ‘Feminisation of Poverty’ the limits of the spine. This

in Africa, Asia and Latin America allows us to double-check
o UKy o s Cortmer v the artwork against the
P o Dot Tl e e e e i . ‘ specification.

Female Labour, Foreign Exchange and Philippine Development (with Cathy
Mclliwaine) and Gender in Latin America (in association with Nikki Craske).

‘Sylvia Chant provides the most lucid treatment to date of the debate

over the relationship between gender and poverty, and, based on new

research from Africa, Latin America and Southeast Asia, critically engages

and moves the discussion beyond the taken-for-granted assumptions that

tend to govern this issue. Essential reading for scholars and policymakers alike.”
- Maxine Molyneux, University of London, UK

‘Sylvia Chant's important new book, Gender, Generation and Poverty,
challenges the widespread, uncritical belief in the feminisation of poverty ~
a central trope in development discourse, which explains both the nature of
(and potential solutions for) global poverty. Drawing on rich, carefully
documented case studies from The Gambia, Philippines and Costa Rica,
Chant amply demonstrates the weaknesses of the feminisation of poverty
perspective, particularly its tendency to link poverty to women, rather than
gender relations, to emphasise women as victims, rather than agents, and to
measure poverty by income privation, rather than grassroots subjective
experiences. Chant calls for a more nuanced approach; one that pays
attention to context, to the impact of gender relations between men and
women and to the way generational change affects the gendered experience
of poverty. Gender, Generation and Poverty thus has profound implications
for both development praxis and theory. It should be required reading for
anyone concerned with avoiding “cookie-cutter” approaches to understanding
and alleviating poverty in an increasingly complex, unequal and insecure
world. | think it is a landmark study, bringing a crucial, critical eye to a
long-held “truism” of development thinking and practice.”

~ Jane L. Parpart, Dalhousie University, Canada

and Visiting Professor, LSE, UK

Sylvia Chant is Professor of Development Geography at the London School

o ABAOJ pue uoneIUID 43pUdn

Jacket design: based on a design by Ralph Kinnear. Photographs by Sylvia Chant.

EDWARD ELGAR PUBLISHING
[ 1-84376-993-
Glensanda House, Montpeler Parade SN 070 1843769934
Chettenna, Glos, GL5D 1UA, UK
To: +44 (0)1242 226834 Fax: +44 (0) 1242 26211
Emait info@e-elgarco uk

Willam Pratt House, 9 Dewey Court
iampton, MA 01060, USA

North
Tel: +1413 584 5551 Fax +1 413 564 9933
Email eigarnfo@e-elgarcom 9781843/769934

W e-elgar.com
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Paperback covers can also be printed on the inside of the cover - remember though that the book needs to be bound
to the inside of the cover, so a white area with no print needs to be allowed for in the spine and 4mm either side of
it for the “side-glue” (a bead of glue that is run up the inside and holds the cover closed onto the book block). In our
example of a book with 16.8mm spine, the total white area width is then 16.8+4+4=24.8mm

Guide to Supplying Print-Ready PDF Files

A Question of Taste
KEITH SALMON

5 Size: (205 x 140)
% ISBN: 9781848974111
é PRICE: £8.99/€1099
g CAT: POLITICAL / LEGAL THRILLER
FORMAT: PAPERBACK
RIGHTS: OLYMPIA PUBLISHERS
TERRITORY: ‘WORLDWIDE
IMPRINT: OLYMPIA PUBLISHERS

ABOUT THE BOOK

The UK Government faces a dilemma. BSE and CJD have resulted in every European
Union member state banning each other's produce. It comes up with the brilliant idea of
Millennium Meat which is a slurry of bugs, slugs and insects which it moulds and flavours
into substitute meat products. So successful is the project's appeal to the EU that the UK
uses it as a means of balancing the nation's pension deficit and thereby avoiding projected
state bankruptcy in 2075,

How it does this is a closely-guarded secret until someone leaks it to the Times newspaper
where Gavin Henderson runs a series of front-page articles. He has to be stopped —
permanently. It looks like the Government will achieve its objectives but, at the eleventh
hour, some Freemasons step into the situation and resolve it in common decency and good
taste.

The book takes us into the inner workings of a number of central government departments,
the press, food research and development companies and, lastly, some of the most closely-
guarded aspects of freemasonry.

ABOUT THE AUTHOR

Keith initially studied Pharmacy, then trained as a creative flavourist with Unilever. He
then entered IT as a programmer and worked his way up to Chief Executive in the City
of London. He worked in litigation support for twenty years on both sides of the Atlantic.
As a freelance consultant, he was an advisor on procurement, modernisation and
efficiency to many UK government departments. He lives in the Scottish borders with
his wife.

Olympia Publishers
Tel: 0207 618 6424 Fax: 0207 002 1100,

E-mail: pressrelease(@olympiapublishers.com
www.olympiapublishers.com
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Dust Jacket Artwork:

| 8 18
<> <= —

246 70

BGCk Flap Height of board

240 160

Front Flap

Width of board

5 aulds

Back Front

Non Text Area Non Text Area
4 ' | | : !
A 1 | | H |
501

In this example, the trim page size of the book is 156mm width by 234mm height. On a
case bound book, the case overhangs the internal pages by 3mm top, bottom and foredge
&, therefore the dust jacket’s visible height (“excluding bleed”) should be 234mm + 3mm
overhang top + 3mm overhang bottom = 240mm.
With 3mm bleed top and bottom, the overall height of the artwork (“including bleed”) is then
246mm.

The “width of board” on the flat-plan also includes an extra millimetre to allow for the thickness of the

board, before the artwork of the flaps start, however any background can be extended beyond this by
3mm if it’s to be seen when the book is closed. Remember that the case boards overhang the text by 3mm, therefore
the front width is 156+3+1 = 160mm. So that no text is visible on the flap when the book is closed, an 8mm non-text
area is recommended between flap and front/back. Flaps can vary in size, but should be in proportion to the book,
between 60mm and 100mm

Again, the spine width may vary slightly (see previous page), so a good design will take this into consideration both at
the spine and between front/back and flaps, such as the example below:

The Speaker’s Chaplain & The Master’s
Daughter can be read alongside its sources,
which are available to readers online. It makes
a significant contribution to social history
and women’s studies in the Georgian period,
not only in its core locus of Winchester and
the county of Hampshire, but elsewhere - in
London, Canterbury, Oxford, Cambridge,
and more widely in Cambridgeshire,
Lincolnshire and Suffolk.

BARRY SHURLOCK lives in Winchester
and has a strong inerest in the cightcenth
century. He went up to Christs College,
Cambridge, from Price’s School, Farcham,
“This book represents several years' work on
material held in the archives of Winchester
College, the oldest continuously active
school in England.

SCHOLARLY SOURCES,
21 Marston Gate,
'WINCHESTER, $023 7DS.
Tel: +44(0)1962 861913

| sy St spasors. craptin Dust st 1
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THE MIDDLING CLASSES in Georgian
England were arguably the backbone of the
country — at least they thought they were.
‘This new study, based on original letters

’l'he speaker’s Chaplain owned by Winchester College, traces the lives

of schoolmaster's daughter Sarah Williams, a
mother of four, and her husband Philip, a
& The Master’s Daughter dleric in search of patronage. His ancestors
from Norch Wales established themselves in
Cambridge, whilst he used the Oxford route.
As a young man he swapped a New College
fellowship for one at Winchester, trekked
¢the Scortish Highlands and worked on an
dicion of the Greek hiscorian Polybivs. His
best friend was the father of daughters who
were intimates of Jane Austen and a son who
proposed o her. His scepfatherwasa peculant
Cambridge don, who endured a farcical
strugele with a Professor of Chemistry over
the Regius Professorship of Divinity.

ypopnyg Arreg

A GEORGIAN FAMILY & FRIENDS

‘The letters depict Philip as a man with all the
ills of pluralism and privilege, but sofrened
by affability and warmed with a genuine
affection for friends and family from a
wide social and geographical horizon. The
domestic minutiae of his life with Sarah
and the ups and downs of their relationship
vividly llustrate the problems faced by people
like them. But these were nothing to those
of her sister, Charlotte, who married the 3rd

976-0-903330-28 -2 viscount Bolingbroke (son of Lady Diana

18BN
RRP:
£25
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Spencer) - he soon deserted her to pursue a
scandalous relationship with his half-sister,
living in Paris. This too palled and he finally
fell in with a German baroness, flecing with
her to Wales and then New Jersey in the
United States.

1
Q
?

Ba.l'l'y Shuflock CONTINUED ON BACK FLAP

| | ] | | 26014 125450
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Printed Paper Case (PPC) Artwork:
I :

Turn-in
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210019
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Back Front

On a PPC book, the cover is printed on paper and then wrapped around and glued to hard board to make a “case”. The
case is then glued (“cased-in”) to the book block by it’s endpapers. Remember that the case overhangs the book block
by 3mm top, bottom and foredge, hence the visible height will be 6mm bigger than the trim-size of the book.

Any background should extend into the 15mm turn-ins (the area which is folded =
over the boards and stuck down behind the endpapers) - there shouldn’t be any
readable text here however, as it will be obscured by the edges of the boards and
the endpapers.

The 8mm grooves—> either side of the spine are where the book hinges open, and also
shouldn’t contain text. Some designs extend the spine background into the grooves, making a
feature of them, others extend the front/back background into them. The example, left, does both
- different back and front.

Again, the spine width may vary slightly (see previous pages), so a good design will take this into consideration

both at the spine and at the edges of the board dimensions, where backgrounds should extend into the turn-ins so the

norma‘l manufacturing fluctuations in positi‘on‘ a‘re not apparent on the final product. ‘

ARIS & PHILLIPS CLASSICAL TEXTS

THUCYDIDES
History Book I

With ion of Book 1P J. he *prequel’to hi ,
Thucydides’ books on the Archidamian War (IT, I and IV.1-V.24). As before
he provides an Introduction on Thucydides’ history and on the Peloponnesian
War, a Greek text with selective critical apparatus and facing translation,
and a commentary which should be useful both to specialists and to readers
with little o no Greek, and which assumes no previous acquaintance with
Thucydides. Matters of text and language are discussed where necessary,
but is on Thucydides’ subj —the War
presented as the greatest war in Greek history, and accounts of the events
directly leading to the war and of the growth of Athenian power since the
Persian Wars which explain why this war between the two great powers of
fifth-century Greece was fought — and on the way in which he has treated it.

SAAIAADNHL,

P.J. Rhodes was Professor of Ancient History and is now Honorary Professor
and Emeritus Professor at the University of Durham. Apart from his other
Thucydides volumes in the Aris & Phillips Classical Texts series his other
books include The Athenian Boule, A Commentary on the Aristotelian
Athenaion Politeia, A History of the Classical Greek World, 478-323 B.C.,
and A Short History of Ancient Greece.
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Other titles in the Aris & Phillips Classical Texts series:
Thucydides: History Il (Rhodes) ARIS & PHILLIPS CLASSICAL TEXTS

Thucydides: History Il (Rhodes)

Thueydides: History IV.1-V.24 (Rhodes)
History

Thucydides Pylos 425 BC (Wilson)
Xenophon: Hellenika I-I1.3.10 (Krentz)
Xenophon: Hellenika I1.3.11-1V.2.8 (Krentz)
[Xenophon]: Old Oligarch: ‘The Athenian Constitution’ (Marr & Rhodes)
Book I

sopoy °['d

A full listing of the Classical Texts series is available on our website
978.1.90834-395.6

www.oxbowbooks.com
sen
9

- ARIS & PHILLIPS

is an imprint of

OXBOW BOOKS
781908 343956

WITH AN INTRODUCTION, TRANSLATION & COMMENTARY BY

P. J. Rhodes

Thucycides HB coverindd 1

| [ ‘
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Brass (Blocking) Artwork:

In order to add a silver, gold (or other basic colour) wording or
design to a cloth case, it is necessary to create a “brass” - a slab §
of metal with the design embossed which is then used to stamp &

the design into the case. In order for us to do this, the artwork 'The
needs to be supplied as black only. Simple graphics can be used § Gibraltar
that are not too intricate and must also be black only at 1200dpi. Law
Images can be converted using Photoshop: Reports

1. Image Menu -> Image Size -> Resolution: 1200dpi;
Resample image (Bicubic smoother if possible); OK.

2. Image menu -> Adjustments -> Threshold - adjust the slider
to best represent the image.

3. Image menu -> Mode -> Greyscale.

4. Image menu -> Mode -> Bitmap; Method: 50% Threshold.

1980-87

The spine, front and back elements should be supplied separately,
and the size of the artwork should be as follows:

All Heights = Height of the trim size + 6mm

Spine Width = As obtained from us.

Front/Back width = Width of trim size minus 4mm.

Remember trim size is the size of the internal book block.

Multiple colours can be used on the same case. Each colour should
be supplied as a separate file. For example, gold lettering can be
overlaid on a block of red colour (called a crusher panel) such as
the example shown. Blind embossing can also be achieved using
similar blocking artwork where no colour is applied. This gives
the effect of the design pressed into the case.

Spot UV Artwork:

Matt laminated covers can have areas of gloss varnish applied called a Spot UV. Artwork for this should be supplied as
black only in the areas that require the varnish (see above for conversion of images to black only). In order to get the
exact position of the varnish correct, it is advised that the cover artwork is copied and amended by changing objects
| N | to black that should have the varnish
applied, and anything else removed.
— The example, left, is the previous PPC

sample that has had this treatment.

STIDOHdOS
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Additional
Components

Plate Sections

This is where a book is to have a separate section or sections printed, perhaps in colour or on a different (usually glossy)
paper stock. Plate sections should be supplied in the same fashion as the main text, but as a separate file or files,
(remember to allow for bleeds). The position of the section within the book may need to be considered, depending
upon the exact manufacturing method of the book - speak to your customer service representative for details. Often,
the main text of a book is printed in sections (e.g. 16 pages to view). Each section is folded to single pages to view,
and several sections collated to make up the book. When a book is produced like this, a plate section can be inserted
between the main sections, but not inside them, for example between the 16th and 17th pages, 32nd and 33rd pages,
48th and 49th pages and so on.

-— Back endpaper Page 3

£\

Printed endpapers

The front endpapers can be printed on pages 2, 3 Back endpaper Page 2
and 4, and the back endpapers on pages 1, 2, and
3. The side that cannot be printed on is glued to
the case. Pages 2 and 3 should be supplied as a
spread, at the height of the trim page size of your §
book and twice it’s width. Pages 1&4 should have a E
4mm white mask down the bind edge to allow for g 3
gluing onto the book block. E =

E

=

Back endpaper Pagel
Front endpaper Page 2
<> Front endpaper Page 4
Front endpaper Page 3 27
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